SAP Quality Issue Management
# Content

1. **Getting Started.** ................................................................. 6
   1.1 About This Document. ....................................................... 6
   1.2 Related Information. ....................................................... 7
      Planning Information. ....................................................... 7
      Further Useful Links. ..................................................... 8
      Related Master Guides. ................................................... 8
   1.3 Important SAP Notes. .................................................... 8

2. **SAP Quality Issue Management Overview.** ............................. 10
   2.1 Software Units of SAP Quality Issue Management. .................. 10
   2.2 Software Component Matrix. .......................................... 11
   2.3 System Landscape. ...................................................... 12
      Minimal System Landscape. .......................................... 12
      Maximal System Landscape. .......................................... 14
      Typical System Landscape. .......................................... 15
   2.4 Business Processes of SAP Quality Issue Management. .......... 16

3. **Installation Information.** .................................................. 18
   3.1 Overall Implementation Sequence. ................................... 18

4. **Operation Information.** .................................................... 20
   4.1 Monitoring of SAP Quality Issue Management. .................... 20
      Alert Monitoring. ......................................................... 20
      Monitoring Installation and Setup. ................................ 20
      Detailed Monitoring and Tools for Problem and Performance Analysis. ........................................... 21
   4.2 Management of SAP Quality Issue Management. .................. 25
      Starting and Stopping. .................................................. 25
      Software Configuration. ................................................. 26
      Administration Tools. .................................................. 27
      Backup and Restore. .................................................... 27
   4.3 Software Change Management. ....................................... 27
      Transport and Change Management. ................................ 27
      Support Packages and Patch Implementation. .................... 28
   4.4 Troubleshooting. .......................................................... 28
      Support Desk Management. ............................................ 28
      Remote Support Setup. ............................................... 28
      Problem Message Handover. ......................................... 29
5  Security Information. ................................................................. 30
5.1 Before You Start. .................................................................... 30
5.2 Technical System Landscape. .................................................. 31
5.3 User Administration and Authentication. ............................... 31
  User Management. ..................................................................... 31
  User Data Synchronization. ...................................................... 33
  Integration into Single Sign-On Environments. ......................... 34
5.4 Authorizations. ................................................................. 34
5.5 Session Security Protection. .................................................. 36
5.6 Network and Communication Security. ............................... 37
  Communication Channel Security. ........................................... 37
  Network Security. ................................................................. 38
  Communications Destinations. ................................................ 38
5.7 Data Protection. ................................................................. 39
  Deletion of Personal Data. ....................................................... 40
  Read Access Logging. ............................................................ 42
5.8 Enterprise Services Security. ................................................ 42
5.9 Security-Relevant Logging and Tracing. ............................... 43
6  Solution-Wide Topics. ............................................................... 44
6.1 List of References. ............................................................... 44
Before you start the implementation, make sure you have the latest version of this document.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2012-07-10</td>
<td>First customer shipment</td>
</tr>
<tr>
<td>2.0</td>
<td>2013-06-07</td>
<td>RTC of SP02 (Feature Pack 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Several document changes related to new SP02 features, for example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Issue processing with Digital Signature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search for issues with Enterprise Search</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BAdI for enhanced authorization check</td>
</tr>
<tr>
<td>2.1</td>
<td>2013-09-27</td>
<td>RTC of SP03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 2.1 changed due to the release of SP03 for installation on SAP NetWeaver AS ABAP 7.4 or SAP NetWeaver AS ABAP 7.4 for Suite on HANA.</td>
</tr>
<tr>
<td>3.0</td>
<td>2014-06-06</td>
<td>RTC of SP04 (Feature Pack 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Several document changes, for example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 2.2: NOTE paragraph deleted since the Scenario &amp; Process Component List is no longer offered.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 2.3.2 updated to include Content Management Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 3.1 updated, mainly regarding post-installation steps.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New section 4.1.3.4 Data Growth and Archiving Monitors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 5.3.1 updated regarding technical users (service user for access to attachments).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 5.7 deleted, since not relevant.</td>
</tr>
<tr>
<td>3.1</td>
<td>2014-08-14</td>
<td>RTC of SP05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Section 3.1, paragraph Post Installation: Two more services listed that need to be activated in transaction SICF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New section 5.7 Data Protection.</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4.0</td>
<td>2015-03-27</td>
<td>RTC of SP07 (Feature Pack 3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Several document changes, mainly related to new SP07 features, for example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Section 3.1, paragraph Post Installation: Five more services listed that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>need to be activated in transaction SICF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Section 4 (Operation Information):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Update of links to SAP NetWeaver documentation and to SAP Support</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Portal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Section 4.1.3: Correction of sub-section numbering</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Section 4.1.3.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New application log object /IAM/NOTIFICATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New application log subobject DATE_DETERMINATION for object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/IAM/COMMON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Section 4.1.3.4: Additional workflow events related to reminders and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>subscriptions (watch list entries)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Section 5 (Security Information):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Update of links to SAP NetWeaver Security Guide</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Section 5.4: New authorization objects related to new user status fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and to reminders and subscriptions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Section 5.8: Update concerning historical texts and change documents</td>
</tr>
<tr>
<td>4.1</td>
<td>2015-06-12</td>
<td>Section 5.7: Update concerning Reported By field</td>
</tr>
<tr>
<td>4.2</td>
<td>2016-06-27</td>
<td>Section 2.2: Update concerning the use of SAP QIM with SAP S/4HANA</td>
</tr>
<tr>
<td>4.3</td>
<td>2017-01-20</td>
<td>Section 2.2: Update concerning the use of SAP QIM with SAP S/4HANA in a side-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by-side scenario</td>
</tr>
</tbody>
</table>
1 Getting Started

1.1 About This Document

Use

This Administrator’s Guide is the central starting point for the technical implementation of SAP Quality Issue Management.

Use this Guide to get an overview of SAP Quality Issue Management, its software units, and its scenarios from a technical perspective. The Administrator’s Guide is a planning tool that helps you to design your system landscape. It refers you to the required detailed documentation.

The Administrator’s Guide is a single source of information to support the implementation and operation of SAP Quality Issue Management. Therefore, it includes the following information:

- Planning Information
  The first chapters of the Administrator’s Guide provide you with overview information about SAP Quality Issue Management including its software units and the system landscape.

- Installation Information
  This chapter gives you an overview of the installation components and the sequence in which they are installed.

- Operation Information
  This chapter provides you with the information that you require to operate SAP Quality Issue Management.

- Security Information
  This chapter provides you with the information that you require to operate SAP Quality Issue Management securely.

Constraints

- The business scenarios that are presented here serve as examples of how you can use SAP software in your company. The business scenarios are only intended as models and do not necessarily run the way they are described here in your customer-specific system landscape. Ensure to check your requirements and systems to determine whether these scenarios can be used productively at your site. Furthermore, we recommend that you test these scenarios thoroughly in your test systems to ensure they are complete and free of errors before going live.

- This Administrator’s Guide primarily discusses the overall technical implementation of SAP Quality Issue Management, rather than its subordinate components. This means that additional software dependencies might exist without being mentioned explicitly in this document. You can find more information about component-specific software dependencies in the corresponding installation guides.
Note

You can find the most current information about the technical implementation of SAP Quality Issue Management and the latest guides on SAP Service Marketplace at http://service.sap.com/instguides.

We strongly recommend that you use the documents available here. The guides are regularly updated.

1.2 Related Information

1.2.1 Planning Information

For more information about planning topics not covered in this guide, see the following content on SAP Service Marketplace or SAP Help Portal:

Table 2:

<table>
<thead>
<tr>
<th>Content</th>
<th>Location on SAP Service Marketplace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest versions of installation and upgrade guides</td>
<td><a href="http://service.sap.com/instguides">http://service.sap.com/instguides</a></td>
</tr>
<tr>
<td>SAP Business Maps – information about applications and business scenarios</td>
<td><a href="http://service.sap.com/businessmaps">http://service.sap.com/businessmaps</a></td>
</tr>
<tr>
<td>Sizing, calculation of hardware requirements – such as CPU, disk and memory resource – with the Quick Sizer tool</td>
<td><a href="http://service.sap.com/quicksizer">http://service.sap.com/quicksizer</a></td>
</tr>
<tr>
<td>Released platforms and technology-related topics such as maintenance strategies and language support</td>
<td><a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a> To access the Platform Availability Matrix directly, enter <a href="http://service.sap.com/pam">http://service.sap.com/pam</a>.</td>
</tr>
<tr>
<td>Network security</td>
<td><a href="http://service.sap.com/securityguide">http://service.sap.com/securityguide</a></td>
</tr>
<tr>
<td>High availability</td>
<td><a href="http://www.sdn.sap.com/irj/sdn/har">http://www.sdn.sap.com/irj/sdn/har</a></td>
</tr>
<tr>
<td>Performance</td>
<td><a href="http://service.sap.com/performance">http://service.sap.com/performance</a></td>
</tr>
<tr>
<td>Information about Support Package Stacks, latest software versions and patch level requirements</td>
<td><a href="http://service.sap.com/sp-stacks">http://service.sap.com/sp-stacks</a></td>
</tr>
<tr>
<td>Information about Unicode technology</td>
<td><a href="http://www.sdn.sap.com/irj/sdn/i18n">http://www.sdn.sap.com/irj/sdn/i18n</a></td>
</tr>
</tbody>
</table>
1.2.2 Further Useful Links

The following table lists further useful links on SAP Service Marketplace:

Table 3:

<table>
<thead>
<tr>
<th>Content</th>
<th>Location on SAP Service Marketplace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information about creating error messages (incidents)</td>
<td><a href="http://service.sap.com/message">http://service.sap.com/message</a></td>
</tr>
<tr>
<td>SAP Notes search</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>SAP Software Distribution Center (software download and ordering of software)</td>
<td><a href="http://service.sap.com/swdc">http://service.sap.com/swdc</a></td>
</tr>
<tr>
<td>SAP Online Knowledge Products (OKPs) – role-specific Learning Maps</td>
<td><a href="http://service.sap.com/rkt">http://service.sap.com/rkt</a></td>
</tr>
</tbody>
</table>

1.2.3 Related Master Guides

This Guide is based on Component Master Guides. You can find more information about the relevant applications in the following documents:

Table 4:

<table>
<thead>
<tr>
<th>Title</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Enhancement Package 1 for SAP NetWeaver 7.3</td>
<td><a href="http://service.sap.com/installNW73">http://service.sap.com/installNW73</a></td>
</tr>
<tr>
<td>SAP Enhancement Package 3 for SAP NetWeaver 7.0</td>
<td><a href="http://service.sap.com/installNW70">http://service.sap.com/installNW70</a></td>
</tr>
</tbody>
</table>

1.3 Important SAP Notes

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find under http://support.sap.com/notes.

Table 5:

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1651318</td>
<td>Overview: Notes on Add-On SAP Quality Issue Management</td>
<td>Release planning information</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>1653529</td>
<td>Overview: Notes on Add-On SAP Issue and Activity Management</td>
<td>Release planning information</td>
</tr>
<tr>
<td>1673333</td>
<td>SAP Quality Issue Management 1.0: Release Information Note (RIN)</td>
<td>Contains information and references to SAP Notes for applying support package (SP) stacks and notes</td>
</tr>
<tr>
<td>1648247</td>
<td>Release strategy for SAP Quality Issue Management</td>
<td>Release planning information</td>
</tr>
<tr>
<td>1640939</td>
<td>Release strategy for SAP Issue and Activity Management</td>
<td>Release planning information</td>
</tr>
<tr>
<td>1651252</td>
<td>Installation of Add-On SAP Quality Issue Management 100</td>
<td>Installation information</td>
</tr>
<tr>
<td>1757913</td>
<td>Support Packages for QAM 100</td>
<td>Upgrade information</td>
</tr>
<tr>
<td>1653502</td>
<td>Installation of Add-On SAP Issue and Activity Management 100</td>
<td>Installation information</td>
</tr>
<tr>
<td>1757914</td>
<td>Support Packages for IAM 100</td>
<td>Upgrade information</td>
</tr>
</tbody>
</table>

**Note**

As of software provisioning manager 1.0 SP07 (SL Toolset 1.0 SP12), the term “product instance” replaces the term “usage type” for SAP systems based on SAP NetWeaver 7.3 including enhancement package 1 and higher. Note that there is no terminology change for older releases and the mentioned terms can be used as synonyms.
With SAP Quality Issue Management, a modern and flexible tool is provided in order to cover issue handling of all kinds and for all industries. It enables an easy tracking and analysis of issues and related activities – also across systems and applications. Furthermore, SAP Quality Issue Management supports integrated scenarios by triggering issues from other applications, linking issues with processes in connected applications, or even by initiating follow-up actions in connected systems during the course of an issue resolution.

Typical Scenario Description

It starts typically with the issue reporter, who detects the issue. This person may not even have access to a system. He or she reports it to an issue submitter who can enter the given information into the SAP Quality Issue Management system.

The issue will be forwarded to the so-called issue driver as the responsible person for a given issue. They would typically check the original information and enrich it by adding further data that can be identified; for example, more concrete reference information, such as recent deliveries, mails related to the issue, and so on. In addition, the issue driver can trigger an initial root-cause analysis, for example, by responding to a list of questions assigned to the issue as activities.

The issue driver can also define the responsible activity drivers, who can be assigned to different departments and business areas, for example, Quality Management, Sales, Purchasing and so on, where the different activities need to be defined.

The activity drivers assign the appropriate activities and forward them to different activity processors, who then take action and execute the given activities.

After completion, the issue driver validates the results; for example, they check whether the taken actions have been sufficient to solve the issue or not. If yes, they can complete the issue and also do a final validation as an effectiveness check.

### 2.1 Software Units of SAP Quality Issue Management

*SAP Quality Issue Management 1.0* can be based on *SAP NetWeaver 7.3* enhancement package 1 or *SAP NetWeaver 7.0* enhancement package 3. The detailed software units required are as follows:

<table>
<thead>
<tr>
<th>Type of Component</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Component</td>
<td>SAP_BASIS 731 (including NWBC)</td>
</tr>
<tr>
<td>Software Component</td>
<td>SAP_BW 731</td>
</tr>
</tbody>
</table>
### 2.2 Software Component Matrix

This section provides an overview of which deployment scenario of SAP Quality Issues Management (SAP QIM) uses which software unit.

For the latest component version and patch level requirements, see [http://service.sap.com/sp-stacks](http://service.sap.com/sp-stacks).

#### Deployment Scenarios

There are three deployment scenarios for SAP QIM, and your installation depends on which scenario you choose.

You can use SAP QIM in the following scenarios:

1. **Standalone**: SAP QIM as a standalone solution
2. **Add-on**: SAP QIM as a complementary solution to an existing system, for example, SAP ERP
   
   In this variant, SAP QIM and SAP ERP run on the same system. You can use the master and organizational data base of SAP ERP.

#### Note

SAP QIM cannot be installed on top of an SAP S/4HANA system. This also means that you cannot convert an SAP ERP system to an SAP S/4HANA system if SAP QIM is installed. You need to uninstall SAP QIM first.
3. **Side-by-side with SAP ERP or SAP S/4HANA**: SAP QIM as a standalone solution parallel to an existing system
   In this variant, SAP QIM and SAP ERP or SAP S/4HANA run on separate systems. The systems communicate via RFC connections or services.

<table>
<thead>
<tr>
<th>Deployment Scenario</th>
<th>SAP QIM as a standalone system</th>
<th>SAP QIM side-by-side</th>
<th>SAP QIM as add-on</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP QIM</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>ADS</strong></td>
<td>X</td>
<td>X</td>
<td>(X)**</td>
</tr>
<tr>
<td><strong>SAP BS FND 731</strong></td>
<td>X</td>
<td>X</td>
<td>(X)**</td>
</tr>
<tr>
<td><strong>SAP NetWeaver AS ABAP 731</strong></td>
<td>X</td>
<td>X</td>
<td>(X)**</td>
</tr>
<tr>
<td><strong>SAP ERP 4.6C</strong></td>
<td>-</td>
<td>(X) full scope*</td>
<td>-</td>
</tr>
<tr>
<td><strong>SAP ERP 6 incl EHP 6</strong></td>
<td>-</td>
<td>(X) full scope*</td>
<td>-</td>
</tr>
<tr>
<td><strong>SAP S/4HANA on-premise</strong></td>
<td>-</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>SAP Solution Manager</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Key: X = mandatory (X) = optional


** As a prerequisite, the SAP ERP system must at least be based on SAP NetWeaver AS ABAP 731.

### 2.3 System Landscape

The following section describes various ways in which the system landscape can be set up.

#### 2.3.1 Minimal System Landscape

**Use**

The following figure provides an overview of a minimal system landscape in SAP Quality Issue Management.
Components

The minimal system landscape involves SAP Quality Issue Management, Adobe Document Services (ADS), and SAP Solution Manager.

SAP Quality Issue Managements consist of the following software components:

- **QAM (Application Component CA-IAM-QIM)**
  This component runs the UI configurations and worklists. It sits above the IAM engine.

- **IAM (Application Component CA-IAM-ENG)**
  The IAM engine is how SAP runs Quality Issue Management. It covers the generic engine for the application.

ADS is needed for printing (see also section Prerequisites).

SAP Solution Manager is useful for installing IAM and connecting to different systems.

Communication Between Back and Front Ends

The communication between back end and front end is HTTP. The applications are accessed from the front end by using SAP NetWeaver Business Client (NWBC). The applications can also be called using SAP NWBC for HTML, a lighter version of NWBC with zero footprint.

Communication with Other SAP Systems

You can communicate with other Suite systems using remote function calls (RFCs).

Prerequisites

The SAP Quality Issue Management system needs SAP NetWeaver Application Server ABAP 7.31, SAP_BS_FND 7.31, and WEBCUIF 7.31.

You need Adobe Document Services (ADS) if you want to print documents such as issue reports. For more information, see SAP NetWeaver Library under Configuration of Adobe Document Services for Print Applications.
Note

ADS does not need to be installed on the same system as SAP QIM. ADS is a service, which has to run in a Java stack. The Java stack can run on the QIM server, on a separate server, or on Solution Manager. When printing mass data, the performance of a productive system can be slowed down.

ADS cannot be installed on an ABAP stack.

2.3.2 Maximal System Landscape

The following figure shows an overview of the maximal system landscape.

![Full System Landscape Diagram]

**Additional Components (compared to Minimal System Landscape)**

**TREX**

The Search and Classification Engine (TREX) runs on a separate server. It supports the search for issues and activities with SAP Enterprise Search.
**SAP NetWeaver Business Warehouse Accelerator**
This powers business intelligence (BI), which helps manage and track issues.

**Business Intelligence (BI)**
This gives you the insight necessary to monitor, manage, and track various quality issues and follow-up actions.

**Enterprise Portal**
SAP Enterprise Portal can be used to access applications from the front end. If you want to use SAP Enterprise Portal as a UI, you need to generate a portal role. You do this by uploading the delivered QIM NWBC role to SAP Enterprise Portal, using a role upload tool. The role upload tool is available as of the SAP Enterprise Portal releases listed in SAP note 1685257. For more information, see the SAP QIM documentation at [http://help.sap.com/qim100](http://help.sap.com/qim100) → Application Help → Roles in SAP Quality Issue Management → Generation of Portal Roles.

**BusinessObjects Enterprise (BOE)**
This platform powers the tools for reporting, query and analysis, and performance management – which helps track and control quality issues and activities.

**Content Management Service (CMS)**
This component of Knowledge Provider (KPro) can be used for storing attachments.

### 2.3.3 Typical System Landscape
The following figure shows a typical system landscape.
Features

Within a typical system landscape, you do not need a separate system for SAP Quality Issue Management. Instead you can install it on any Suite system – preferably on SAP ERP with SAP NetWeaver AS ABAP 7.31 underneath.

Components

SAP Quality Issue Management uses Adobe printing for the printouts – this needs the ADS. Finally, you should use SAP Solution Manager to drive the installation.

2.4 Business Processes of SAP Quality Issue Management

A quality issue management scenario typically consists of the following processes:

Capturing and Processing Issues

1. Create an issue
2. Manage and coordinate an issue
3. Analyze individual defects and causes
4. Analyze related issues  
5. Assign and coordinate activities  
6. Validate and complete an issue  
7. Archive issues  

**Conducting an 8D Problem Analysis**  
1. Trigger problem analysis  
2. Process problem analysis  
3. Print 8D report  

**Processing Activities Related to an Issue**  
1. Process an activity  
2. Trigger follow-up actions  
3. Check effectiveness of a measure  
4. Confirm an activity  
5. Archive activities  

**Monitoring and Coordinating Issues and Activities**  
1. Monitor issues across multiple sources  
2. Monitor activities across multiple sources  
3. Perform mass processing of issues and activities  

**Analyzing Issues and Activities**  
1. Define KPIs for issues and activities  
2. Use a dashboard for issue and activity analysis  
3. Create a report at enterprise level  
4. Analyze trends  

For more information, see the documentation in SAP Solution Manager under [Solutions/Applications > SAP Quality Issue Management > Scenarios](https://www.sap.com).
3 Installation Information

3.1 Overall Implementation Sequence

This section describes the implementation sequence for SAP Quality Issue Management. The first two deployment scenarios are installed in the same way.

Note

For the latest component version and patch level requirements, as well as more detailed information about the installation process for SAP Quality Issue Management, see the Notes mentioned below.

Notes

- Installation note software component IAM: [1653502](http://help.sap.com/nw731)
- Installation note software component QAM: [1651252](http://help.sap.com/nw731)

Installation Sequence

**SAP QIM Standalone and SAP QIM Side-By-Side with SAP ERP**

1. Install (or update) SAP NW AS ABAP 731
2. Install IAM 100 layer
3. Install QAM 100
4. Install SAP NetWeaver Business Client (NWBC) for Desktop (optional)

**SAP QIM on ERP**

1. Install (or update) SAP NW AS ABAP 731
2. Install (or update) SAP ERP (best integration as of ERP 6.0 EHP 6)
3. Install IAM 100 layer
4. Install QAM 100
5. Install NWBC for Desktop (optional)

If you want to use NWBC for Desktop (instead of or in addition to) NWBC for HMTL, a client setup is necessary. You should download the latest version of NWBC for desktop, and then uninstall the old version before installing the new version. For more information about NWBC for Desktop, see the SAP NetWeaver Business Client documentation [http://help.sap.com/nw731](http://help.sap.com/nw731) » SAP NetWeaver Library: Function-Oriented View » Application Server » Application Server ABAP » UI Technology in ABAP » SAP NetWeaver Business Client

Post-Installation

1. You must manually activate the following services as follows after the installation. Otherwise the error message *Service cannot be reached* is displayed.
   1. Choose transaction SICF.
   2. Under *Hierarchy Type*, enter *SERVICE* and execute.
3. Navigate to the applications via the path

`default_host > sap > bc > webdynpro > sap` and activate the following services:

- QAM_CATEGORY_INFO
- QIM_ACT_ID_LINK_CAT
- QIM_GAP_ISSUE_CRT
- QIM_GQIA_POWL_OVP
- QIM_MANAGE_REMINDERS
- QIM_MANAGE_WATCH_LISTS
- QIM_OVP_ACTIVITY
- QIM_OVP_ISSUE
- QIM_OVP_ISSUE_CRT
- QIM_OVP_NOTIFIER
- QIM_SUBISSUE_ID
- WDR_CHIP_PAGE
- IBO_WDR_INBOX
- FDT_WD_WORKBENCH

2. In addition, you need to make the following settings in transaction SICF:

1. For the navigation and usage of the NWBC for HTML you need to activate the service NWBC (path: `default_host/sap/bc/`).

2. If you use attachments in QIM, you need to activate the service CONTENTSERVER (path: `default_host/sap/bc/`). In the CONTENTSERVER settings you need to assign a user for anonymous access with user type `Service`, created in transaction SU01. Do not assign any permissions to this user.

3. If you use SAP Business Workflow, you need to activate the service WEBGUI (path: `default_host/sap/bc/gui/sap/its/`). In the WEBGUI settings, the GUI Link needs to be specified with `Yes`.

4. You need to activate the service MIMES (path: `default_host/sap/public/bc/its/`). In the MIMES settings, the GUI Link must not be specified.

3. In transaction SE80, you need to publish the Internet Services SYSTEM and WEBGUI on the INTERNAL site.

4. Delivery Customizing is imported into client 000 and may have to be copied to other clients. For more information, see SAP Note 337623.

5. If you want to use SAP Enterprise Portal as a UI, you need to generate a portal role. You do this by uploading the delivered QIM NWBC role to SAP Enterprise Portal, using a role upload tool. The role upload tool is available as of the SAP Enterprise Portal releases listed in SAP Note 1685257. For more information, see the SAP QIM documentation at [http://help.sap.com/qim100](http://help.sap.com/qim100) Application Help > Roles in SAP Quality Issue Management > Generation of Portal Roles.
4 Operation Information

4.1 Monitoring of SAP Quality Issue Management

Within the management of SAP technology, monitoring is an essential task. A section has therefore been devoted solely to this subject.


4.1.1 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment. SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to recognize critical situations for SAP Quality Issue Management 1.0 as quickly as possible.

SAP Quality Issue Management 1.0 does not offer specific data in the Computer Center Management System (CCMS) for alert monitoring. Nevertheless general monitoring options can be used.


4.1.2 Monitoring Installation and Setup

There are no additional steps besides the ones described in the installation guide to setup SAP Quality Issue Management monitoring.

In order to enable the auto-alert mechanism of CCMS, see SAP Note 617547.
4.1.3 Detailed Monitoring and Tools for Problem and Performance Analysis

4.1.3.1 BRFplus Traces

SAP Quality Issue Management supports the use of SAP Business Rules Framework plus (BRFplus) to:

- Determine business partners for issues and activities
- Determine additional activities for issues
- Find experts for certain activities
- Determine dates for issues and activities and traffic light icons in the issue hierarchy

It is not recommended to activate these BRFplus traces for long periods of time as they are performance critical.

Trace data can be found in the BRFplus Workbench as follows:

1. Start transaction BRFplus to open the BRFplus Workbench.
2. Switch to expert mode by choosing Personalize User Mode Expert.
3. In the Tools menu choose Lean Trace.
4. Find/name the required BRFplus function using the given selection data.
5. Start the search to see any trace data if available.

4.1.3.2 Trace and Log Files

Trace files and log files are essential for analyzing problems.

The standard SAP NetWeaver tools such as transactions ST22 (Run Time Errors) and SM21 (System Log) can be used to monitor trace and log files. For more information, see the Technical Operations Manual for SAP NetWeaver under: http://help.sap.com/nw731 System Administration and Maintenance Information Technical Operations for SAP NetWeaver Administration of Application Server ABAP Monitoring and Administration Tools for Application Server ABAP Trace Functions and System Log.

4.1.3.3 Application Logs

SAP Quality Issue Management uses the application log (part of SAP NetWeaver) to store error, warning, and success messages issued in critical processes or in UI transactions.


The following application log entities hold entries of relevance for SAP Quality Issue Management and can be monitored with transaction SLG1:

Object /IAM/COMMON
Messages related to entities located in the IAM layer:

- **Subobject CATEGORY**
  Messages resulting from access to **reference objects** using certain **object categories**. Activities and issues have object references with categories defined in the IAM layer. See, for example, MAT_ERP, BAT_ERP.

- **Subobject DATE_DETERMINATION**
  Messages resulting from the execution of the **date determination** for an issue and its subordinated activities.

- **Subobject FOLLOWUP**
  Messages resulting from the execution of **follow-up actions** (activities) in issue processing.

- **Subobject GTYPE_ACCESS**
  Messages resulting from the access to **reference objects** using certain **object types**. Issues and activities have object references with object types defined in the IAM layer. See, for example, BAT (Batch), CUS (Customer), DLI (Outbound Delivery Item).

- **Subobject METHOD**
  Messages resulting from the execution of **actions for reference objects**. Activities and issues could have object references where actions are performed.

**Object QAM_COMMON**

Messages related to objects located in the QIM layer:

- **Subobject CATEGORY**
  Messages resulting from access to object categories in the **QIM worklists** for activities and issues. For example, QA_AUD (Audit), QA_FMEA (FMEA), QA_QA (QAM Activity), QI_QI (QAM Issues), QI_QI_DF (QAM Defects), QI_QMNO (Quality Notification).

- **Subobject CUSTWIZARD**
  Messages resulting from QIM customizing wizards.

- **Subobject GQI_ACCESS**
  Messages resulting from access to generic quality issues.

- **Subobject GQA_ACCESS**
  Messages resulting from access to generic quality activities.

- **Subobject GTYPE_ACCESS**
  Messages resulting from the access to **reference objects** of issues and activities in issue and activity processing, having types defined in the QIM layer. See, for example, I (generic quality issue), A (Quality Activity).

- **Subobject METHOD**
  Messages resulting from the execution of actions for items in the generic issue and activity worklist.

**Object CDSG1**

Messages related to digital signatures:

- **Subobject /IAM/ISS**
  Messages related to the digital signature of business transactions concerning issues.

- **Subobject /IAM/ACT**
  Messages related to the digital signature of business transactions concerning activities.

**Object /IAM/NOTIFICATION**

- **Subobject REMINDERS**
  Messages related to the sending of reminder notifications

- **Subobject SUBSCRIPTIONS**
  Messages related to the sending of subscription notifications
In addition, the following specific trace and log tools are available:

<table>
<thead>
<tr>
<th>Monitoring Object</th>
<th>Monitor Transaction/ Tool</th>
<th>Frequency</th>
<th>Indicator or Error Handling Procedure</th>
<th>Who</th>
</tr>
</thead>
</table>
### 4.1.3.4 Workflow Event Queues and Traces

SAP Quality Issue Management triggers SAP business workflow events. In order to monitor them and to find and analyze any problems related to such events, the tools for SAP business workflow event queue administration (transaction SWEQADM) and browsing can be used. The events related to SAP Quality Issue Management should be listed with the following object IDs.

For events related to **issues**:
- /IAM/CL_ISSUE_WF_CONNECT
- CL_QAM_ISSUE_WF_CONNECT

For events related to **activities**:
- /IAM/CL_ACTIVITY_WF_CONNECT
- CL_QAM_ACTIVITY_WF_CONNECT
For events related to **watch list** and **reminders**:  
- `/IAM/CL_NOTIFIER_WF_CONNECT`  
- `CL_QAM_NOTIFIER_WF_CONNECT`  

### 4.1.3.5 Data Growth and Data Archiving Monitors

The following tables are the top five fastest growing tables in SAP QIM:

- `/IAM/D_I_ROOT`
- `/IAM/D_I_PARTY`
- `/IAM/D_I_OBJ_REF`
- `/IAM/D_ACT_PARTY`
- `/IAM/D_ACT_ROOT`

You can archive the data of these tables in Archive Administration (transaction **SARA**), using the following archiving objects:

- `/IAM/ACT` for QIM activities
- `/IAM/ISSUE` for QIM issues

### 4.2 Management of SAP Quality Issue Management

SAP provides you with an infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation.

Additional information can be found in SAP Solution Manager documentation on SAP Help Portal at [http://help.sap.com](http://help.sap.com).


#### 4.2.1 Starting and Stopping

The stop sequence is in reverse order to the start sequence.

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Sequence</th>
<th>Tool</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NW 7.31</td>
<td>1</td>
<td>STARTSAP / STOPSAP (Unix) SAPMMC (Windows)</td>
<td>-</td>
</tr>
<tr>
<td>Software Component</td>
<td>Sequence</td>
<td>Tool</td>
<td>Comments</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP BS_FND</td>
<td>2</td>
<td>STARTSAP / STOPSAP (Unix) SAPMMC (Windows)</td>
<td>-</td>
</tr>
<tr>
<td>SAP ERP 6.0 EHP3</td>
<td>3</td>
<td>STARTSAP / STOPSAP (Unix) SAPMMC (Windows)</td>
<td>Only if QIM is running as an add-on otherwise it’s independent from the rest</td>
</tr>
<tr>
<td>QIM/IAM ABAP Server</td>
<td>4</td>
<td>STARTSAP / STOPSAP (Unix) SAPMMC (Windows)</td>
<td>-</td>
</tr>
<tr>
<td>AS Java*</td>
<td>5</td>
<td>Depending on the system landscape</td>
<td>Required for Adobe ADS</td>
</tr>
</tbody>
</table>

For more information about STARTSAP/STOPSAP and SAPMMC, see [Application Help > Function-Oriented View > Solution Life Cycle Management > Starting and Stopping SAP Systems Based on SAP NetWeaver](http://help.sap.com/nw731).

*Starting and Stopping Application Server Java*

If you want to print from SAP Quality Issue Management, you have to be able to start/stop the Application Server Java (AS Java, formerly known as J2EE Engine). Depending on your operating system and how you installed the AS Java in your system landscape, different procedures apply.

For detailed documentation about starting and stopping the AS Java, see [Application Help > Function-Oriented View > Application Server > Application Server Java (AS Java) > Administering Application Server Java > Administration > The Startup Framework for AS Java](http://help.sap.com/nw731).

### 4.2.2 Software Configuration

This chapter explains which components or scenarios used by this application are configurable and which tools are available for adjusting.

The Implementation Guide (IMG) is the standard SAP tool for component Customizing. To display the Implementation Guide (IMG) on the SAP Easy Access screen choose [Tools > Customizing > IMG > Execute Project](transaction SPRO).

Customizing settings for SAP Quality Issue Management can be found under [Cross-Application Components > Quality Issue Management](http://help.sap.com/nw731).

Also, see detailed configuration settings in the SAP Quality Issue Management section of SAP Solution Manager.
4.2.3 Administration Tools

Most of the SAP Quality Issue Management tools are based on SAP NetWeaver AS ABAP 7.31. For more information, see http://help.sap.com/nw731

4.2.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of failure.

The backup and restore strategy for SAP Quality Issue Management consists of two parts:

- Backup and restore coverage for each component
- Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should also be embedded in overall business requirements and incorporate your company’s entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data center through fire. It is most important in this context that you ensure that backup devices are not lost together with normal data storage (separation of storage locations).

Based on the type of application data contained in a component, a categorization scheme for system components can be used to analyze the backup requirements of any system component and to easily determine an appropriate backup method for this component.

For more information, see:

- SAP NetWeaver documentation under http://help.sap.com/nw731
- Best practices document Backup and Restore under http://service.sap.com/bp-roadmap

4.3 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing procedures for complex software landscapes and multiple software development platforms. These functions support your project teams, development teams, and application support teams.

4.3.1 Transport and Change Management

All components of SAP Quality Issue Management are client-enabled. For transport and change management issues, the procedures of SAP NetWeaver apply. For more information, see http://help.sap.com/nw731
4.3.2 Support Packages and Patch Implementation

We recommend that you implement Support Package Stacks (SP Stacks), which are sets of support packages and patches for the respective product version that must be used in the given combination. The technology for applying support packages and patches will not change.

Read the corresponding Release and Information Notes (RIN) (SAP Note 1673333 for SAP QIM) before you apply any support packages or patches of the selected SP Stack. Use the Maintenance Optimizer (transaction DSWP) of the SAP Solution Manager to select, download, and install the needed software components and required support packages. For more information, see the following:

- SAP Solution Manager documentation on SAP Help Portal at http://help.sap.com
- SAP Service Marketplace at http://service.sap.com/solman-mopz
- The documentation for transaction SAINT (SAP Add-On Installation Tool)

For more information about the implementation of support packages as well as possible side effects, see the following:

- http://support.sap.com/patches
- http://support.sap.com/notes

4.4 Troubleshooting

4.4.1 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to run your internal support organization efficiently.

4.4.2 Remote Support Setup

SAP support needs to be able to work remotely for highest efficiency and availability. Therefore all required support tools must be remotely accessible for SAP support.
For SAP QIM, the standard SAP procedures for setting up remote support apply. For more information about accessing support remotely, see [https://support.sap.com/Remote Support](https://support.sap.com/Remote Support).

For more information about setting up an HTTP connection, see SAP Note [592085](https://support.sap.com/592085). An HTTP connection is required to open an NWBC application from the support system.

In SAP QIM, the standard SAP NetWeaver support roles are used to provide remote support. In addition, the support role `SAP_QIM_SUPPORT` with display authorization is available in the QIM system.

### 4.4.3 Problem Message Handover

For information about processing support messages (incidents) and forwarding them to SAP, see the following:

- [https://support.sap.com/Knowledge Base & Incidents](https://support.sap.com/Knowledge Base & Incidents)

To send incidents to SAP, choose the appropriate component (or subcomponent) name from the SAP component hierarchy. The following components are relevant for SAP QIM:

- **CA-IAM-ENG** (for issues related to the general IAM layer)
- **CA-IAM-QIM** (for issues related to QIM business logic)
5 Security Information

5.1 Before You Start

SAP QIM can be deployed as standalone solution based on SAP NetWeaver 7.0 including enhancement package 3 or SAP NetWeaver 7.3 including enhancement package 1. SAP QIM can also be connected to other applications, for example, SAP ERP. Therefore, the corresponding Security Guides also apply to SAP QIM. Pay particular attention to the most relevant sections or specific restrictions as indicated in the table below.

Table 10:

<table>
<thead>
<tr>
<th>Component</th>
<th>Corresponding Security Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP ERP</td>
<td><a href="http://service.sap.com/securityguide">http://service.sap.com/securityguide</a> SAP Business Suite Applications SAP ERP, for example, 6.0</td>
</tr>
</tbody>
</table>

For a complete list of the available SAP Security Guides, see http://service.sap.com/securityguide on SAP Service Marketplace.

Important SAP Notes

At the moment, there are no special SAP Notes regarding security for SAP QIM. For a list of additional security-relevant SAP Hot News and SAP Notes, see also SAP Service Marketplace at http://service.sap.com/securitynotes.
5.2  Technical System Landscape

For more information about the technical system landscape, see the resources listed in the table below and the System Landscape section above.

Table 11:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Guide/Tool</th>
<th>Quick Link to the SAP Service Marketplace or SDN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical landscape design</td>
<td>See applicable documents</td>
<td><a href="http://sdn.sap.com/irj/sdn/landscape-design">http://sdn.sap.com/irj/sdn/landscape-design</a></td>
</tr>
</tbody>
</table>

5.3  User Administration and Authentication

SAP Quality Issue Management uses the user management and authentication mechanisms provided with the SAP NetWeaver platform, in particular the SAP NetWeaver Application Server ABAP. Therefore, the security recommendations and guidelines for user administration and authentication as described in the SAP NetWeaver Application Server ABAP Security Guide apply to SAP Quality Issue Management.

In addition to these guidelines, we include information about user administration and authentication that specifically applies to the SAP Quality Issue Management application in the following topics.

5.3.1  User Management

User management for SAP Quality Issue Management uses the mechanisms provided with the SAP NetWeaver Application Server (ABAP), for example, tools, user types, and password policies. For more information, see [http://help.sap.com/nw731](http://help.sap.com/nw731) Application Help > Function-Oriented View > Solution Life Cycle Management > Security and User Administration.

For an overview of how these mechanisms apply for SAP Quality Issue Management, see the sections below. In addition, we provide a list of the standard users required for operating SAP Quality Issue Management.

User Administration Tools

The table below shows the tools to use for user management and user administration with SAP Quality Issue Management.
Table 12: User Management Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User maintenance for ABAP-based systems (transaction SU01)</td>
<td>For more information about the authorization objects provided by SAP Quality Issue Management, see the section Authorizations [page 34].</td>
</tr>
<tr>
<td>Role maintenance with the profile generator for ABAP-based systems (PFCG)</td>
<td>For more information about the roles provided by SAP Quality Issue Management, see the section Authorizations [page 34].</td>
</tr>
<tr>
<td>Central User Administration (CUA) for the maintenance of multiple ABAP-based systems</td>
<td>Use the CUA to centrally maintain users for multiple ABAP-based systems. Synchronization with a directory server is also supported.</td>
</tr>
<tr>
<td>Report /IAM/APP_CREATE_BUPA</td>
<td>This report supports you in creating business partners for the system users, for example, that you have imported from an external system.</td>
</tr>
</tbody>
</table>

User Types

It is often necessary to specify different security policies for different types of users. For example, your policy may specify that individual users who perform tasks interactively have to change their passwords on a regular basis, but not those users under which background processing jobs run.

The user types that are required for the SAP Quality Issue Management include:

- **Individual users:**
  - Dialog users are used for NWBC for Desktop and for RFC connections to navigate into detail views for objects (like materials or quality notifications) located in other logical systems (used for SAP GUI for Windows or RFC connections).
  - Internet users are used for NWBC for HTML. (The same policies apply as for dialog users, but used for Internet connections.) Moreover, these users could be used if it is intended to attach and use URLs as attachments within QIM application.

- **Technical users:**
  - If you use attachments in SAP Quality Issue Management, you need to assign a service user for anonymous access in transaction SICF in the CONTENTSERVER settings. Do not assign any permissions to this user.
  - Communication users are used for getting detailed information via RFC without dialog on objects that SAP Quality Issue Management refers to and that are located in other systems.
  - So far, no background users are used for SAP Quality Issue Management.

For more information about these user types, see User Types in the SAP NetWeaver Application Server ABAP Security Guide.

Standard Users

The table below shows the standard users that are necessary for operating SAP Quality Issue Management.
<table>
<thead>
<tr>
<th>System where QIM is installed and systems QIM is connected to</th>
<th>User ID</th>
<th>Type</th>
<th>Password</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;User 1&gt;</td>
<td>Dialog user</td>
<td>You specify the initial password during the installation.</td>
<td>The main users for QIM, needed for QIM application itself (if NWBC for Desktop is intended to be used) and for navigation into e.g. master data detail information in the system itself or in other systems connected to QIM.</td>
<td></td>
</tr>
<tr>
<td>System where QIM is installed</td>
<td>&lt;User 2&gt;</td>
<td>Internet user</td>
<td>You specify the initial password during the installation.</td>
<td>If it is intended to use NWBC for HTML, then this kind of user is needed for the QIM application additionally to the dialog user.</td>
</tr>
<tr>
<td>System where QIM is installed and systems QIM is connected to</td>
<td>&lt;User 3&gt;</td>
<td>Communication user</td>
<td>The user ID and password are stored in the RFC destination for the connection.</td>
<td>To read, triggered by QIM application, detail information e.g. on master data in the system itself or in other systems connected to QIM.</td>
</tr>
</tbody>
</table>

No users are delivered with SAP Quality Issue Management. You need to make sure that the users are available when you start to configure the application.

### 5.3.2 User Data Synchronization

5.3.3 Integration into Single Sign-On Environments

The SAP Quality Issue Management application supports the Single Sign-On (SSO) mechanisms provided by SAP NetWeaver. Therefore, the security recommendations and guidelines for user administration and authentication as described in the SAP NetWeaver Security Guide also apply.

The most widely-used supported mechanisms are listed below.

- **Secure Network Communications (SNC)**
 
  SNC is available for user authentication and provides for an SSO environment when using the SAP GUI for Windows or Remote Function Calls.

- **SAP logon tickets**

  The SAP Quality Issue Management application supports the use of logon tickets for SSO when using a Web browser as the frontend client. In this case, users can be issued a logon ticket after they have authenticated themselves with the initial SAP system. The ticket can then be submitted to other systems (SAP or external systems) as an authentication token. The user does not need to enter a user ID or password for authentication but can access the system directly after the system has checked the logon ticket.

- **Client certificates**

  As an alternative to user authentication using a user ID and passwords, users using a Web browser as a frontend client can also provide X.509 client certificates to use for authentication. In this case, user authentication is performed on the Web server using the Secure Sockets Layer Protocol (SSL Protocol) and no passwords have to be transferred. User authorizations are valid in accordance with the authorization concept in the SAP system.

  For more information, about the available authentication mechanisms, see the User Authentication and Single Sign-On chapter in the *SAP NetWeaver Library*.

5.4 Authorizations

The *SAP Quality Issue Management* application uses the authorization concept provided by the SAP NetWeaver AS ABAP. Therefore, the recommendations and guidelines for authorizations as described in the SAP NetWeaver AS ABAP Security Guide also apply to the *SAP Quality Issue Management* application.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For role maintenance, use the profile generator (transaction **PFCG**) on the AS ABAP.

**Standard Roles**

The table below shows the standard PFCG roles that are used by the *SAP Quality Issue Management* application. The authorization objects for these roles are supplied by SAP in the profiles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_QIM_COORDINATOR</td>
<td>SAP Quality Issue Management Coordinator, coordinating issues and performing some system administration tasks</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>SAP_QIM_ISSUE_DRIVER</strong></td>
<td>SAP Quality Issue Management Issue Driver, responsible for an issue</td>
</tr>
<tr>
<td><strong>SAP_QIM_SUPPORT</strong></td>
<td>Display or read-only authorization for support purposes only</td>
</tr>
<tr>
<td><strong>SAP_QIM_WF</strong></td>
<td>SAP Quality Issue Management Workflow authorizations (batch)</td>
</tr>
<tr>
<td><strong>SAP_BC_FDT_ADMINISTRATOR</strong></td>
<td>BRFplus Administrator</td>
</tr>
<tr>
<td><strong>SAP_BCV_ADMIN2</strong></td>
<td>Business Context Viewer Administrator</td>
</tr>
<tr>
<td><strong>SAP_BCV_USER</strong></td>
<td>Business Context Viewer User</td>
</tr>
<tr>
<td><strong>SAP_MDG_ADMIN</strong></td>
<td>Master Data Governance: Administrator</td>
</tr>
<tr>
<td><strong>SAP_BC_SRV_ASF_AT_ADMIN</strong></td>
<td>Audit Trail (ILM): Administrator</td>
</tr>
<tr>
<td><strong>SAP_BC_SRV_ASF_AT_USER</strong></td>
<td>Audit Trail (ILM): Minimum Authorization for Evaluation of Audit Trail Data</td>
</tr>
<tr>
<td><strong>SAP_ESH_LOCAL_ADMIN</strong></td>
<td>Embedded Search (Composite): Administration and Monitoring</td>
</tr>
</tbody>
</table>

For authorizations concerning digital signatures, no PFCG roles are delivered. The relevant authorizations are controlled with the authorization objects `C_SIGN` and `C_SIGN_BGR`.

**Authorization Objects**

The table below shows the authorization objects that are delivered the *SAP Quality Issue Management* application.

**Table 15:**

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAM_CAT_AC</td>
<td>Authorization to Restrict Access to SAP Quality Issue Management Worklist Object</td>
</tr>
<tr>
<td>/IAM/IAUTH</td>
<td>Authorization Object for Issue</td>
</tr>
<tr>
<td>/IAM/IAUTH</td>
<td>Authorization Object for Activity</td>
</tr>
<tr>
<td>/IAM/ATTMT</td>
<td>Authorization Object for Attachments for Issue/Activity</td>
</tr>
<tr>
<td>/IAM/OREF</td>
<td>Authorization Object for Reference Objects for Issue and Activity</td>
</tr>
<tr>
<td>/IAM/A_ATTR</td>
<td>Authorization Object for Attribute Maintenance for Activity</td>
</tr>
<tr>
<td>IAM_CODEGR</td>
<td>Authorization Object for Code Groups</td>
</tr>
<tr>
<td>Authorization Object</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>/IAM/TXTTY</td>
<td>Authorization Object for Descriptions</td>
</tr>
<tr>
<td>IAM/A_STAT</td>
<td>Authorization Object for Lifecycle Status (Activity)</td>
</tr>
<tr>
<td>IAM/I_STAT</td>
<td>Authorization Object for Lifecycle Status (Issue)</td>
</tr>
<tr>
<td>IAM/A_RLCD</td>
<td>Authorization Object for Role Codes in Activity</td>
</tr>
<tr>
<td>IAM/I_RLCD</td>
<td>Authorization Object for Role Codes in Issue</td>
</tr>
<tr>
<td>/IAM/CODGR</td>
<td>Authorization Object for Selection of Code Groups/Codes</td>
</tr>
<tr>
<td>IAM/I_USTA</td>
<td>Authorization Object for User Status Action (Issue)</td>
</tr>
<tr>
<td>IAM/A_USTA</td>
<td>Authorization Object for User Status Action (Issue)</td>
</tr>
<tr>
<td>/IAM/REMIN</td>
<td>Authorization Object for Reminders</td>
</tr>
<tr>
<td>/IAM/SUBSC</td>
<td>Authorization Object for Subscriptions</td>
</tr>
</tbody>
</table>

With the Business Add-In (BAdI) /IAM/BADI_ISSUE_AUTHORITY you can dynamically extend the authorization of a user. This means, for example, you can grant authorization to display or change individual objects to a user who actually does not have this authorization in SAP QIM.

5.5 Session Security Protection

To increase security and prevent access to the SAP logon ticket and security session cookie(s), it is recommended that you activate secure session management. We also highly recommend using SSL to protect the network communications where these security-relevant cookies are transferred.

Session Security Protection on the AS ABAP

The following section is relevant for SAP QIM in SAP NetWeaver Business Client: To prevent access in javascript or plug-ins to the SAP logon ticket and security session cookies (SAP_SESSIONID_<sid>_<client>). You can activate secure session management. With an existing security session, users can then start applications that require a user logon without logging on again. When a security session is ended, the system also ends all applications that are linked to this security session.
Use the transaction SICF_SESSIONS to specify the following parameter values shown in the table below in your AS ABAP system:

Table 16: Session Security Protection Profile Parameters

<table>
<thead>
<tr>
<th>Profile Parameter</th>
<th>Recommended Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>icf/set_HTTPonly_flag_on_cookies</td>
<td>0</td>
<td>Client-dependent</td>
</tr>
<tr>
<td>login/ticket_only_by_https</td>
<td>1</td>
<td>Not client-dependent</td>
</tr>
</tbody>
</table>

5.6 Network and Communication Security

Your network infrastructure is extremely important in protecting your system. Your network needs to support the communication necessary for your business needs without allowing unauthorized access. A well-defined network topology can eliminate many security threats based on software flaws (at both the operating system and application level) or network attacks such as eavesdropping. If users cannot log on to your application or database servers at the operating system or database layer, then there is no way for intruders to compromise the machines and gain access to the backend system’s database or files. Additionally, if users are not able to connect to the server LAN (local area network), they cannot exploit well-known bugs and security holes in network services on the server machines.

The network topology for the SAP Quality Issue Management application is based on the topology used by the SAP NetWeaver platform. Therefore, the security guidelines and recommendations described in the SAP NetWeaver Security Guide also apply to the SAP Quality Issue Management application. Details that specifically apply are described in the following sections.

5.6.1 Communication Channel Security

The table below shows the communication channels used by the SAP Quality Issue Management application, the protocol used for the connection and the type of data transferred.

Table 17:

<table>
<thead>
<tr>
<th>Communication Path</th>
<th>Protocol Used</th>
<th>Type of Data Transferred</th>
<th>Data Requiring Special Protection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frontend client using SAP GUI for Windows to application server</td>
<td>RFC, HTTP(S)</td>
<td>Integration data</td>
<td>Passwords</td>
</tr>
<tr>
<td>Frontend client using a Web browser to application server</td>
<td>HTTPS</td>
<td>All application data</td>
<td>Passwords</td>
</tr>
<tr>
<td>Application server to third-party application</td>
<td>HTTPS</td>
<td>System ID, client, and host name</td>
<td>System information (that is, host name)</td>
</tr>
</tbody>
</table>
### 5.6.2 Network Security

Your network infrastructure plays a key role in protecting your system. A well-defined network topology can eliminate many security threats based on software flaws (at the operating system and application level) or network attacks such as eavesdropping. We offer general recommendations to protect your system landscape, based on SAP NetWeaver.


A minimum security demand for your network infrastructure is the use of a firewall for all your services that are provided over the Internet. A more secure variant is to protect your systems (or groups of systems) by locating the system groups in different network segments. Each system group has a firewall that protects it from unauthorized access. External security attacks can also come from the inside, if the intruder has already taken control of one of your systems. For more information, see [SAP NetWeaver Security Guide > Network and Communication Security > Using Firewall Systems for Access Control](http://help.sap.com/nw73).

SAP QIM uses a so-called “document domain relaxing” in order to navigate into the objects and does not offer protected applications. Nevertheless, it is possible to establish a DMZ with an SAP Portal via Multiple Network Zone. For more information, see: [SAP NetWeaver Security Guide > Network and Communication Security > Using Multiple Network Zones](http://help.sap.com/nw73).

**Note**

It is not possible to use the NWBC client here. You need to generate a portal role out of the shipped PFCG roles for SAP QIM. The generated portal role covers the same functionality like the PFCG role for NWBC.

### 5.6.3 Communications Destinations

The use of users and authorizations in an irresponsible manner can pose security risks. You should therefore follow the security rules below when communicating with other systems:

- Employ the user types system and communication.
• Grant a user only the minimum authorizations.
• Choose a secure password and do not divulge it to anyone else.
• Only store user-specific logon data for users of type system and communication.
• Wherever possible, use trusted system functions instead of user-specific logon data.

For navigation with NWBC for Desktop, it is necessary to make entries in table HTTP_WHITELIST. For more information, see http://help.sap.com/nw731.}

5.7 Data Protection

Data protection is associated with numerous legal requirements and privacy concerns. In addition to compliance with general data privacy acts, it is necessary to consider compliance with industry-specific legislation in different countries. This section describes the specific features and functions that SAP provides to support compliance with the relevant legal requirements and data privacy. This section and any other sections in this Security Guide do not give any advice on whether these features and functions are the best method to support company, industry, regional or country-specific requirements. Furthermore, this guide does not give any advice or recommendations with regard to additional features that would be required in a particular environment; decisions related to data protection must be made on a case-by-case basis and under consideration of the given system landscape and the applicable legal requirements.

Note

In the majority of cases, compliance with data privacy laws is not a product feature. SAP software supports data privacy by providing security features and specific data-protection-relevant functions such as functions for the simplified blocking and deletion of personal data. SAP does not provide legal advice in any form. The definitions and other terms used in this guide are not taken from any given legal source.

Table 18: Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal data</td>
<td>Information about an identified or identifiable natural person.</td>
</tr>
<tr>
<td>Business purpose</td>
<td>A legal, contractual, or in other form justified reason for the processing of personal data. The assumption is that any purpose has an end that is usually already defined when the purpose starts.</td>
</tr>
<tr>
<td>Blocking</td>
<td>A method of restricting access to data for which the primary business purpose has ended.</td>
</tr>
<tr>
<td>Deletion</td>
<td>Deletion of personal data so that the data is no longer usable.</td>
</tr>
<tr>
<td>Retention period</td>
<td>The time period during which data must be available.</td>
</tr>
</tbody>
</table>
Term | Definition
--- | ---
End of purpose (EoP) | A method of identifying the point in time for a data set when the processing of personal data is no longer required for the primary business purpose. After the EoP has been reached, the data is blocked and can only be accessed by users with special authorization.

Some basic requirements that support data protection are often referred to as technical and organizational measures (TOM). The following topics are related to data protection and require appropriate TOMs:

- **Access control**: Authentication features as described in section User Administration and Authentication.
- **Authorizations**: Authorization concept as described in section Authorizations.
- **Read access logging**: as described in section Read Access Logging.
- **Transmission control**: as described in section Network and Communication Security.
- **Availability control** as described in:
  - SAP NetWeaver Database Administration documentation
- **Separation by purpose**: Is subject to the organizational model implemented and must be applied as part of the authorization concept.

⚠️ **Caution**

The extent to which data protection is ensured depends on secure system operation. Network security, security note implementation, adequate logging of system changes, and appropriate usage of the system are the basic technical requirements for compliance with data privacy legislation and other legislation.

### 5.7.1 Deletion of Personal Data

**Use**

SAP QIM might process data (personal data) that is subject to the data protection laws applicable in specific countries as described in SAP Note 1825544. The SAP Information Lifecycle Management (ILM) component supports the entire software lifecycle including the storage, retention, blocking, and deletion of data. SAP QIM uses SAP ILM to support the deletion of personal data as described in the following sections. SAP delivers an end of purpose check for business partners, customers and vendors assigned to QIM quality issues and activities. For information about the settings required, see Customizing for QIM under Environment Define End of Purpose for Personal Data.

**End of Purpose Check (EoP)**

An end of purpose check determines whether data is still relevant for business activities based on the retention period defined for the data. The retention period of data consists of the following phases.
Phase one: The relevant data is actively used.
Phase two: The relevant data is actively available in the system.
Phase three: The relevant data needs to be retained for other reasons.
For example, processing of data is no longer required for the primary business purpose, but to comply with legal rules for retention, the data must still be available. In phase three, the relevant data is blocked. Blocking of data prevents the business users of SAP applications from displaying and using data that may include personal data and is no longer relevant for business activities.

Blocking of data can impact system behavior in the following ways:

- Display: The system does not display blocked data.
- Change: It is not possible to change a business object that contains blocked data.
- Create: It is not possible to create a business object that contains blocked data.
- Copy/Follow-Up: It is not possible to copy a business object or perform follow-up activities for a business object that contains blocked data.
- Search: It is not possible to search for blocked data or to search for a business object using blocked data in the search criteria.

It is possible to display blocked data if a user has special authorization; however, it is still not possible to create, change, copy, or perform follow-up activities on blocked data.

### Relevant Application Objects and Available Deletion Functionality

Table 19:

<table>
<thead>
<tr>
<th>Application Object</th>
<th>Detailed Description</th>
<th>Provided Deletion Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality Issue</td>
<td>Quality issues created in SAP QIM</td>
<td>Archiving Object /IAM/ISSUE, Related ILM Object IAM_ISSUE</td>
</tr>
<tr>
<td>Quality Activity</td>
<td>Quality activities created in SAP QIM</td>
<td>Archiving Object /IAM/ACT, Related ILM Object IAM_ACTIVITY</td>
</tr>
</tbody>
</table>

### Relevant Application Objects and Available EoP functionality

Table 20:

<table>
<thead>
<tr>
<th>Application Object</th>
<th>Detailed Description</th>
<th>Implemented Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Partner</td>
<td>Business partners assigned as partners to quality issues or activities</td>
<td>EoP check</td>
</tr>
<tr>
<td>Customer</td>
<td>Assigned as reference object</td>
<td>EoP check</td>
</tr>
<tr>
<td>Vendor</td>
<td>Assigned as reference object</td>
<td>EoP check</td>
</tr>
</tbody>
</table>

⚠️ Caution

Note that the Reported By field that is available for quality issues is a free text field. Therefore it is not included in the EoP check. Within your organization, make sure that only data is stored in this field that is not subject to data protection.
Procedure

1. Before archiving data, you must define residence time and retention periods in SAP Information Lifecycle Management (ILM).
2. You choose whether data deletion is required for data stored in archive files or data stored in the database, also depending on the type of deletion functionality available.
3. You do the following:
   ○ Run transaction IRMPOL and maintain the required residence policies for the central business partner (ILM object: CA_BUPA, application IAM).
   ○ Run transaction BUPA_PRE_EOP to enable the end of purpose check function for the central business partner.
   ○ Run transaction IRMPOL and maintain the required residence policies for the customer and vendor reference in QIM (ILM object CA_BUPA, application IAM_CUS for customers and IAM_VEN for vendors).
   ○ Run transaction CVP_PRE_EOP to enable the end of purpose check function for the customer master and vendor master in SAP ERP.
4. Business users can request unblocking of blocked data by using the transaction BUP_REQ_UNBLK.
5. If you have the needed authorizations, you can unblock data by running the transaction BUPA_PRE_EOP and CVP_UNBLOCK_MD.
6. You delete data by using the transaction ILM_DESTRUCTION for the ILM objects of SAP QIM.

For information about how to configure blocking and deletion for SAP QIM, see Customizing for QIM under Environment Define End of Purpose for Personal Data.

5.7.2 Read Access Logging

If no trace or log is stored that records which business users have accessed data, it is difficult to track the person(s) responsible for any data leaks to the outside world. The Read Access Logging (RAL) component can be used to monitor and log read access to data and provide information such as which business users accessed personal data, for example, of a business partner, and in which time frame. In RAL, you can configure which read-access information to log and under which conditions.


5.8 Enterprise Services Security

The following chapters in the NetWeaver Security Guide are relevant for all enterprise services delivered with SAP Quality Issue Management:


- User Administration and Authentication
5.9 Security-Relevant Logging and Tracing


Changes to an issue or activity in SAP Quality Issue Management are documented by means of change documents. In addition, you can specify for each text type that a history is stored for the long texts entered in the various text areas (historical texts). For more information, see the SAP Library for SAP QIM under http://help.sap.com/qim100 Application Help > SAP Library > Issue Processing.
6 Solution-Wide Topics

6.1 List of References

The following is a list of references to technologies used for SAP Quality Issue Management.

Information about technologies in SAP NetWeaver can be found on SAP Help Portal at [http://help.sap.com/nw73][1].

Table 21:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Technologies, for example, Web Dynpro, ABAP, Floorplan Manager, NWBC</td>
<td>[SAP NetWeaver Library: Function-Oriented View][2] [Application Server][3] ABAP [UI Technologies in ABAP][4]</td>
</tr>
<tr>
<td>Search and Operational Analytics</td>
<td>[SAP NetWeaver Library: Function-Oriented View][2] [Search and Operational Analytics][3]</td>
</tr>
<tr>
<td>Adobe Document Services for Form Processing</td>
<td>[SAP NetWeaver Library: Function-Oriented View][2] [Application Server][3] ABAP [Adobe Document Services for Form Processing][3]</td>
</tr>
</tbody>
</table>

Information about additional technologies being re-used by SAP QIM can be found in the SAP QIM documentation on SAP Help Portal at [http://help.sap.com/qim100][6].
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).